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External Drive Recommendations

For optimal performance, it is strongly recommended that 
high RPM drives (7200 or greater) with large on-board 
caching (8MB or greater) are used.
Always check your external drive with the X-48’s Drive 
Benchmarking Utility under the File menu.

Drive Formatting

Since the X-48 is a hard drive intensive product, certain 
procedures must be followed to ensure expected error-free 
operation.  These procedures are of particular importance 
on external FireWire drives due to their reduced bandwidth 
compared to the internal drive:

If 3 – 5 projects have been recorded onto a drive, then •	
deleted, the drive should be formatted without “Quick 
Format” checked.

A drive used for a long record pass should be formatted •	
first without “Quick Format” checked.

Time Code

To ensure proper recording while synchronized, the X-48 
must now be in a locked state to external timecode and clock 
before entering record.  This is consistent with previous 
TASCAM recorders (DTRS, MX-2424).

Display size

The X-48 display size can be changed to match various 
types and sizes of screen size, e.g. wide screen or other 
larger screens. Select “Display Settings” from the Windows 
menu to bring up a dialog that shows the available screen 
sizes.

Important items

Always use the most recent firmware for this device. Please 
visit the TASCAM web site at http://www.tascam.com to 
check for the latest firmware.  

Updates
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Manual Update

Version 1.04

Supported Optical Media

Supported:•	
DVD-R	 Read/Write
DVD-RW	 Read/Write/Rewrite
DVD+R	 Read/Write
DVD+RW	 Read/Write

Not Supported:•	
DVD+RW rewrite
Dual Layer media
“For Audio Only” or “For Music Only” CD media

Clock Channels
Following are valid digital inputs for receiving digital audio 
clock:
Built-in TDIF	 Port1 (Channels 1-8)
IF-AE24(X)	 Slot 1 (Channels 1&2) or 
		  Slot 2 (Channels 25&26)
IF-AD24(X) 	 Slot 1 (Channels 1&2) or 
		  Slot 2 (Channels 25&26) 

Mounting FireWire Drives
To mount a FireWire drive, it must be powered off when 
connected to the X-48.  It will then mount when powered 
on.  Once unmounted, it has to be powered off then on again 
to mount again.

OSX Networking Requirements
To connect via Ethernet to a Mac, the Mac must be running 
OSX 10.4.0 or higher.

Booting the X-48
When booting the X-48, do not leave a USB flash drive 
connected.  If that occurs:
1.	 Press F1 To Continue when prompted

2.	 Remove the USB flash drive

It may be necessary for the machine to be booted a few 
times without a USB flash drive to clear the condition.

Drive Formatting
Since the X-48 is a hard drive intensive product, certain 
procedures must be followed to ensure expected error-free 
operation.  These procedures are of particular importance 
on external FireWire drives due to their reduced bandwidth 
compared to the internal drive:

If 3 – 5 projects have been recorded onto a drive, then •	
deleted, the drive should be formatted without “Quick 
Format” checked.

A drive used for a long record pass should be formatted •	
first without “Quick Format” checked.

Project Transfer:  MX-2424 to X-48
1.	 Mount a FAT-32 MX-2424 SCSI drive containing the 

project to be transferred onto a computer.

2.	 Transfer the project to the X-48 be any of the following 
methods:

a.	 Copy it to a FireWire drive that can be mounted on 
the X-48

b.	 Share the X-48’s drive with the computer via network 
then copy the project from the drive mounted on the 
computer to the X-48’s drive.

c.	 Burn the project to CD or DVD, move that disk to the 
X-48, and copy the project to the X-48’s drive.

3.	 Select Import from the X-48’s File Menu and Import the 
OpenTL project.

Theater Play Mode
The X-48 can be set to a special mode where it steps through 
location points as a series of “cues”. This can be useful 
when triggering material and sound effects for Theater, 
Radio Stations, etc.

To enter this mode, select Theater Play as the Control Mode 
in either the LCD or VGA user interface.

In this mode, it is possible to play and navigate through a 
series of “cues”.  Each cue is defined by the times contained 
in a pair of memory locations.  Cue number 1 starts at 
the time in Memory location #00, and finishes at the time 
specified by Memory #01.  Cue #2 goes from Memory #02 
to Memory #03, and so on.  

The desired locate points must already exist in the project 
before using Theatre Play mode.

To begin, select “Theatre Play” mode then load the 
appropriate project (with the desired locate points already 
stored within that project).  Theatre Play mode may be 
selected after loading the desired project.

These actions will result in the X-48 locating automatically 
to the start of the first cue, the location contained in Memory 
#00.  The project must contain an even number of memory 
locations, ie. #00 through #07 (#00 counts as one).  If the 
project contains an odd number of memory locations, the 
transport will not move beyond the last one.

Pressing PLAY will cause the X-48 to play from the start 
of the first cue (Memory #00) to its end (Memory #01), and 
then immediately locate to the beginning of the next cue and 
stop, (Memory #02) awaiting another Play command.

When a footswitch is inserted into the back panel 
“Footswitch” jack, each cue can be triggered, one at a time, 
by pressing on the footswitch.  In other words, in “Theatre 
Play” mode, a footswitch is another PLAY key. 

Manual Addendum
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BUSY Indications
When the front panel BUSY LED is illuminated and/
or the VGA cursor is shown as an hourglass, the X-48 is 
processing CPU or disk intensive operations.  During this 
time, important operations such as Save should not be 
performed.

Removing The Top Panel
When removing the X-48’s top panel to install optional I/O 
cards (Owner’s Manual Pages 13 & 14), please note that the 
top panel screws are not all the same.  The center and rear 
top panel screws are different from the four corner screws.  
Set them aside separately to be replaced in their same 
positions to avoid stripping the screw holes or screws.

ADR Mode
When in ADR Mode, the front panel Auto Input LED will 
flash.  It is possible to disable ADR Mode by pressing the 
front panel Auto Input key, but it is only possible to enable 
ADR Mode from the LCD or VGA interfaces.

Chase Freewheel
An Infinite setting as available as a Chase Freewheel choice 
to allow the X-48 to continue to play or record regardless of 
incoming timecode.

Audio Pool
The X-48’s VGA UI includes an Audio Pool window, which 
is accessed by pressing CTRL+P or by selecting Audio 
Pool under the Windows menu.  The Audio Pool will also 
automatically be presented when a project references any 
audio files that it cannot find.  The Audio Pool supports the 
following utility functions:

Relink:•	  
If a Region in a project references an audio file that 
cannot be found, click on the Region then click on Relink 
to navigate to the missing audio file and re-establish 
the link between the region and the audio file.  This can 
occur if audio data is manually moved from its original 
location, or if audio data exists on an external drive that 
is not currently mounted, or if audio data is renamed 
while its drive is not connected to the X-48.

Rename:•	  This allows an audio file within a project to be 
renamed without causing a file that would need manual 
relinking.

Remove:•	  This allows a project’s reference to an audio 
file to be permanently removed if it is known that the 
audio file will no longer be needed.
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Typos

The Read & Surf section on Page 9 refers to “Quick Start •	
Guide”.  This should be “Quick Reference Guide”.

Item #8 on Page 12 incorrectly omitted Tri Level sync in •	
addition to the stated blackburst.

On Page 37, the paragraph describing Pre/Post Roll is a •	
duplicate of the previous section on Rehearse.  The Pre/
Post Roll description should be:

	 Pre Roll and Post Roll are used during Loop and 
Auto Punch operations to have the specified amount 
of transport motion before the In point and/or after 
the Out point.

On Page 52, the paragraph describing Audio File Naming •	
may be confusing.  It should be:

	 The X-48 can auto-name new audio files either based 
on the project name or the track name. This setting 
can only be changed from the GUI.  Since there 
are no track names visible when using the LCD, it 
defaults to naming audio files based on the project 
name. 

On Page 59, the paragraph under DSP View describing •	
the Track section refers to an Input Routing pulldown 
that does not exist in this location.  The Input Routing 
pulldown is per-track in the Track View.

Page 19 of the X-48 Owner’s Manual incorrectly refers to •	
the pre-installed version of TASCAM Mixer Companion 
software as 1.30.  X-48 Version 1.00 includes Version 
1.50 of TASCAM Mixer Companion.

Backup
1.	 On page 35 of the Owner’s Manual, it incorrectly states 

that data may be backed up to a network. The only valid 
backup destinations are optical media and hard drive.

2.	 Only one project may be backed up at a time.

Operating Environment
The X-48 can be used in most areas, but to maintain 
top performance and prolong operating life, observe the 
following operating conditions:

The nominal temperature should be between 5°C and •	
40°C.

Relative humidity should be 30% (5°C) to 80% (32°C).•	

Installing Plug-Ins
On page 61 of the Owner’s Manual, the plug-in installation 
instructions are incomplete.  Please follow the steps below:
1.	 Insert the plug-in installer CD

a.	 You will see the installer CD’s AutoRun splash 
screen

2.	 Follow the on-screen instructions for installing the 
plug-in.

a.	 Accept all defaults.
b.	 If you are prompted to quit the x48.exe application 

because the installer is attempting to modify it, click 
Ignore.

3.	 The installer will prompt you to restart the X-48

4.	 Shutdown and restart and allow the installer to 
complete its operations

5.	 Shut down the X-48

6.	 Insert the iLok dongle

7.	 Power on the X-48

Your plug-ins will be available under the Inserts •	
pulldown menu of the Mixer’s DSP view.

Supported Plug-ins
Please note that only the following plug-ins are officially 
supported at this time:

Waves 5•	

Antares Auto-Tune 4•	

Antares Auto-Tune 5•	

Footswitch Operation
Pages 12 and 16 describe footswitch usage for general
transport control and punching into & out of record.
In all versions from V1.00, the footswitch implementation is
restricted to issuing Play commands for use with Theater
Play mode.

Manual Corrections
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The Big Meter Screen, which allows meters for all 48 •	
tracks to be seen at the same time, has been added. Select 
this from the Big Meters under Windows Menu.

Fail Safe Recording. The X-48 now constantly •	
checkpoints the audio files every 5 seconds during 
recording. If power is lost, a dialog appears after power 
is turned back on asking whether to restore the lost 
audio. This fixes the newly recorded audio clips up to the 
last checkpoint.

Disk Cleanup and Undo History.  From the edit menu, •	
the history list has a Clear button. This button brings up 
a dialog that now also allows unused and unnecessary 
audio files to be deleted from the drive.

Files can now be automatically named based on the •	
project name and track name.

°	 Select “Take#_Track#_ProjectName_TrackName” 
for the “Audio File Naming” setting on the Settings 
Window, Prefs tab.

When opening a project from the LCD, files other than •	
project files had been shown, but now only project files 
(.ndr) are shown, making it easier to choose them.

An automation WRITE switch has been added to the •	
screen and the function has been made easier to use.

Indication for the Destructive mode has been added to •	
the top center of the VGA screen, making monitoring of 
its status easier.

NOTE
This shows the same state as the Destructive LED 
(SYSTEM-DEST REC) on the X-48 operation panel.

By adding a drive benchmark test function, it is now •	
possible to display data transfer capacity as an equivalent 
number of tracks at each sample rate.

NOTE
Although the X-48 cannot physically record more than 
48 simultaneous tracks, benchmarking allows you to 
determine whether a disk will handle heavy punch 
ins which can require up to double the number of disk 
accesses at the instant of the punch in and out point.

°	 Choose “Drive Benchmarking…” from the File menu 
and select a drive to execute this test.

Previously, only Open Loop MMC control was •	
supported. X-48 V1.10 now supports closed loop MMC 
control as well.

New Features

V1.10 additions

V1.04 additions

To ensure proper recording while synchronized, the •	
X-48 must now be in a locked state to external timecode 
and clock before entering record.  This is consistent with 
previous TASCAM recorders (DTRS, MX-2424).

New keyboard shortcuts have been added:•	

°	 “I” sets a punch-in point.

°	 “O” sets a punch-out point.

In the I/O tab of the Settings window, it is now possible •	
to select “Professional” or “Consumer” mode for the S/
PDIF output.

It is now possible to use the CTRL+C (copy) and •	
CTRL+V (paste) shortcuts from a QWERTY keyboard to 
copy/paste text in the Track Screen’s track naming fields.
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The File Manager now displays file and folder sizes.  File •	
sizes are displayed automatically.  Click on a folder to 
display its size.

The network name of the X-48 can now be changed.  •	
This is the name that appears in your computer’s network 
UI when connected to the X-48.  To change this name, 
select Set X48 Name under the File menu in the VGA UI.

Clip names are now displayed in the upper left corner of •	
audio regions in the Edit Window of the VGA UI.

It is now possible to specify a name for audio files •	
resulting from a Consolidate operation.  When selecting 
Consolidate from the Process menu, a dialog will prompt 
for the desired file name.

Informative progress bars are now presented for OpenTL •	
export and File Manager copy operations.

It is now possible to perform AAF exports as either •	
embedded AAF files or non-embedded AAF projects.  
When selecting Export Project from the File menu, the 
Export Filter will present the new AAF choices along 
with the already existing OpenTL choice.

°	 Embedded AAF files contain all the project 
information and audio files in one single file.  Such a 
file cannot exceed 2GB in size.

°	 Non-embedded AAF projects contain an AAF file 
and separate copies of the original audio files, all 
in one folder that can easily be copied or moved to 
another system without affecting the original source 
data.  While any single audio file within a project is 
subject to the same 2GB file size limit, the total size 
of a Referenced AAF export is not limited.

V1.03 additions

V1.02 additions

There is now a Remaining Disk Space indicator at the •	
top of the VGA UI, next to the CPU meter.
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When snapping was set to subframe and looping was •	
on, locating with the I-beam between the Loop In and 
Out points could cause the unit to freeze. This has been 
fixed.

When three continuous audio clips were lined up on one •	
track, they might not playback as expected. This has 
been fixed.

When set to double speed sample rates (88.2k, 96k) and •	
when no audio clips were on a track, external timecode 
could not be followed. This has been fixed.

Keyboard shortcuts did not work when the Caps Lock •	
key was ON. This has been fixed.

During loop playback, the MTC time output would not •	
loop and would continue linearly. This has been fixed.

If a project had been created and recorded using the X-48 •	
front panel without connecting a mouse or keyboard, 
connecting a mouse or keyboard later could cause 
application errors. This has been fixed.

When “Snapping” was active and set to “Subframes,” •	
putting data from the copy buffer into an already 
existing clip could cause the transport to move strangely 
and eventually freeze. This has been fixed.

Audio clips would not play back correctly where they •	
overlapped. This has been fixed.

Drop timecode output by the X-48 was incorrectly •	
flagged as non-drop timecode by external devices. This 
has been fixed.

AES double speed settings could not be made from the •	
X-48 LCD or using key operations. This has been fixed.

Sometimes the X-48 froze during startup if an AES card •	
was in Slot1. This has been fixed.

When Load Last Project was ON and Auto Input was •	
OFF, recording 48 tracks at 96 kHz and then playing 
back from the start of a project caused freezing about 
two seconds from the start. This has been fixed.

Formatting the hard disk volume currently in use had •	
been possible from the front panel. This is now disabled.

When Load Last Project was ON, if a project were •	
opened after start-up, markers that were set to times after 
12:00:00 would all move to exactly 12:00:00. This has 
been fixed.

If you tried to export an Open TL file of a project that •	
was 2 GB or greater, a message related to AAF files 
appeared erroneously. (“The exported file will exceed 
the maximum file size allowed. Try a non-embedded 
export.”) Now there is no limit on OpenTL project export 
size.

If a TASCAM ID REQUEST was made using a Sony •	

P2 command, a response would be sent using an MMR8 
ID even thought it is an X-48. This has been fixed and 
responses are made correctly with the X-48 ID.

The X-48 Sony P2 function was replying with an ACK •	
for all commands, including unsupported commands. 
Now unsupported commands generate a NAK reply.

The speed of shuttle/jog Sony P2 commands and the •	
actual playback speed of the X-48 did not match. This 
has been fixed.

The EXT MNT LED turned off when a project was •	
opened and operations were conducted. This is been 
fixed.

The TC CHASE key LED sometimes flashed •	
unexpectedly. This has been fixed.

When copying a project using front panel operations, if •	
the “XProjects” folder did not exist as a copy destination, 
the copy function failed. This has been fixed.

Unmounting an external drive could cause the LCD •	
display to go blank. This has been fixed.

When the clock setting was something other than •	
WORD, there was a problem with the BNC IN multiplier 
(/2,x2) becoming effective. This has been fixed.

Some types of operations caused recorded audio clips to •	
be erased. This has been fixed. 

The Relock Threshold setting could not be made from •	
the LCD screen. This has been fixed.

Even when all tracks were not armed, setting the •	
transport to REC would cause the REC LED to light 
solid. This has been fixed, so now it flashes.

In theater mode, when marker #0 was at 00:00:00:00, •	
pressing the REW key would not cause playback to 
return to marker #0. This has been fixed.

AAF Files exported by the X-48 could not be imported •	
by ProTools 7.2-7.3, but this issue has been resolved with 
ProTools 7.4.

Even if audio clips were locked, Crop, Insert time and •	
Delete time operations could be used on them. This has 
been fixed. 

If the current project was backed up and then •	
immediately restored, this could cause a freeze. This has 
been fixed.

During recording, changing the Mixer Bypass setting •	
caused a beeping sound and recordings were interrupted. 
This has been fixed.

Pressing the power button during recording caused the •	
unit to shut down, but now the power button has been 
set to not respond during recording to prevent accidental 
loss of data.

Maintenance Items

V1.10 changes
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Optimizations have been made to reduce CPU resources •	
used by the VGA user interface while recording.

Previously, rare cases were reported of tracks playing out •	
of time.  This has been fixed in 1.04.

Previously, destructive recording mode would leave files •	
on the hard drive beyond the expected one audio file per 
track.  This has been corrected in 1.04.

Previously, mixer automation data was incorrectly being •	
written whenever a fader was moved while the transport 
was in motion.  From Version 1.04, automation data must 
be drawn in the track screen.

Previously, the X-48 would incorrectly output a timecode •	
burst upon locate when the Timecode Output Muting 
parameter was set to Play Only.  This has been corrected 
for consistency with the MX-2424.

The status indicators and meters on the VGA UI are now •	
brighter for improved visibility.

V1.04 changes

AUX pre/post switching mixer functions and some Aux •	
2, 4 and 6 functions did not work properly. This has been 
fixed.

In 2x sample mode, if the master clock was set to AES, •	
the left and right AES audio signals were reversed. This 
has been fixed. However, if the master clock is set to 
AES in 2x sample mode, TDIF left and right signals will 
be reversed. Set the master clock to WORD to avoid this.

Changes have been made to reduce or eliminate •	
instability when creating/loading/saving a project, or 
when editing.

Previously, automation playback was not functional.  •	
This has been fixed in 1.03.

Previously, files created on the X-48 had permissions set •	
such that they could not be copied to certain Windows 
OS configurations.  This has been fixed in 1.03.  In order 
for these changes to affect existing data, the following 
steps must be followed:

a.	 Update to 1.03
b.	 Copy all data to another drive (or back up the data)
c.	 Format the source drive using Disk Management 

from the File menu

d.	 Copy all the data back to the original source drive 
(or perform a Restore)

Previously, when set to 2X sample rates, the X-48 would •	
not chase time code unless audio data already existed in 
the project.  This has been fixed in 1.03.

Previously, imported audio would incorrectly reference •	
the source media upon playback until the source media 
was unmounted.  This has been fixed in 1.03.

In very rare cases, the X-48 could lose lock when •	
resolved to video and chasing time code.

Previously, multiple-DVD backups could cause •	
instability.  This has been fixed in 1.03.

V1.03 changes
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Previously, the X-48 could not chase incoming MTC •	
(MIDI Time Code).  This has been corrected in Version 
1.02.

Previously, broadcast wave audio files did not correctly •	
spot to their original time code location when importing 
into an X-48 project.  This has been corrected in Version 
1.02.

Previously, the front panel timecode rate LED would not •	
illuminate when the X-48 was powered on.  This has 
been corrected in Version 1.02.

Previously, some audio files could not be directly •	
imported from a data CD or DVD.  This has been 
corrected in Version 1.02.

Previously, it was not possible to disable Track Key •	
Punch.  This has been corrected in Version 1.02.

V1.02 changes

Previously, I/O cards installed would not appear in the •	
I/O tab of the Settings window, even though the I/O 
cards were functional.  This has been corrected.

Previously, the OL indicator time out was not functional.  •	
This has been corrected.

V1.01 changes
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The following corrections to Theater Play Mode operations 
have been made:

While in Theater Play mode, the FF and REW buttons •	
locate to the beginning of the next or previous cue.

Pressing STOP in the middle of a cue will cause the X-48 •	
to stop as expected.  The PLAY is subsequently pressed, 
the X-48 will locate back to the top of the current cue 
and begin playing.

Recording is not possible in Theater Play Mode.•	

When Theater Play Mode is selected and a project is •	
loaded with markers, the X-48 will automatically locate 
to the first marker and stop, awaiting a play command.

The LCD will display the name of the currently loaded •	
project in the top line of the LCD and the current cue in 
the bottom line.

Known Issues

Known Issues in Version 1.10

“Drive sharing…” can be selected from the menu to •	
permit disk access from a network, but it might not 
function depending on the environment. Most such cases 
can be resolved by launching the Windows file manager 
from “Disk Management” in the X-48 menu and setting 
it to allow sharing of the relevant folder.

If ADR is selected and Auto Input is active, with punch •	
in and out, when punching out, the audio monitoring 
sound will be cut off temporarily. However, this does not 
affect the recording when punch out is used.

When you turn Mixer Bypass OFF, the audio playback •	
will be slightly delayed by a fixed amount compared to 
the actual time code time. Set Mixer Bypass to ON to 
playback with strict timing with another device.

The following operations have been found to not leave •	
an UNDO option in the History List when an audio clip 
is moved (dragged). Please use caution if you want to use 
the UNDO function.

°	  When the left button of the mouse is used to select 
any audio clip

°	  When a selected audio clip is dragged to any 
position while the left button is held down

°	  When playback is conducted by pressing the PLAY 
button or the space bar

It has been reported that a problem with Panasonic/•	
Canopus SONY P2 commands causes some operations 
from the Canopus to make the X-48 enter PLAY mode 
unexpectedly. 

Other Issues

V1.02 specification changes
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The US-2400’s Scrub/Shuttle wheel is not currently •	
compatible with the X-48’s transport engine.

 4X sample rates (ie. 192k) are not supported•	

Closed Loop MMC (MIDI Machine Control) is not •	
supported in Version 1.00.  Open Loop MMC may be 
used in place of Closed Loop MMC.

The X-48’s front panel DISK LED illuminates based •	
on audio record/playback.  It will not illuminate during 
drive to drive copy or network operations.

Stereo Aux Returns cannot be unlocked for dual mono •	
operation.

When installed in the X-48, an IF-AD24(X) does not •	
support S/MUX functionality.

Using the Consolidate command under the Edit menu is •	
not supported on selected time lengths greater than eight 
hours.

Project names that contain a period “.” will not display •	
correctly in the front panel LCD.

The I/O Operating Level should be set to 20dB when •	
doing digital transfers from the X-48 to ensure correct 
transfer level.

After unmounting an external drive, the LCD will go •	
blank.  Press a front panel shortcut key, such as SYNC, 
then CLEAR/HOME to return the LCD to normal 
operation.

The 24.975 video reference rate is untested.•	

Dual line output from the IF-AE24(X) at 2X sample •	
rates is not supported.

The X-48 supports 1080p Tri Level Sync.  It does not •	
support 720p Tri Level Sync.  1080i is untested.

Destructive mode attempts to estimate the amount of •	
disk space needed to record and consolidate the audio 
files any time the machine enters record.  This process 
contains some conservative assumptions which may 
produce overly large estimates resulting in not enough 
disk space.  Please ensure you have plenty of disk space 
before doing heavy punching into a destructive mode 
project.

When recording high track counts, just after transport •	
motion begins, there is a slight UI/playhead pause.  This 
does not affect recorded audio.

Import / Export

OpenTL project exports from Apple Logic Pro do not •	
import into the X-48 since the referenced audio files are 
Sound Designer II.

OpenTL project exports from Nuendo 3 may not import •	
into the X-48.

OpenTL project exports from the X-48 cannot be opened •	
in Steinberg’s Nuendo.  Use AAF instead.

An OpenTL project created on an MX-2424 then •	
imported into an X-48 does not properly export to a Pro 
Tools compatible AAF.  Projects that originate on the 
X-48 are not affected.

AAF exports that result in destination audio file sizes •	
greater than 2GB are not supported.

If an error occurs while importing a project, causing •	
the error dialog to appear, the mouse cannot be used to 
dismiss the error dialog.  The workaround is to press 
ESC.

OpenTL volume automation is not supported.•	

Only the currently open project may be exported to •	
OpenTL or AAF.

A progress bar is not shown during an OpenTL export.•	

An AAF export from the X-48 will not import into Pro •	
Tools 7.3, but will import into previous versions of Pro 
Tools.  An update to Pro Tools is expected to correct this.

Notes

Notes on V1.04 and others
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